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Introduction

Welcome to the tenth edition of Networking For Dummies, the book
that’s written especially for people who have this nagging feeling in
the back of their minds that they should network their computers but haven’t
a clue about how to start or where to begin.

Do you often copy a spreadsheet to a flash drive just so you can give it to
someone else in your office? Are you frustrated because you can’t use the
fancy color laser printer that’s on the financial secretary’s computer? Do you
wait in line to use the computer that has the customer database? You need a
network!

Or maybe you already have a network, but you have just one problem:
Someone promised that a network would make your life easier, but it’s
instead turned your computing life upside down. Just when you had this
computer thing figured out, someone popped into your office, hooked up a
cable, and said, “Happy networking!” Makes you want to scream.

Regardless, you've found the right book. Help is here, within these humble
pages.

This book talks about networks in everyday (and often irreverent) terms. The
language is friendly; you don’t need a graduate education to get through it.
And the occasional potshot helps unseat the hallowed and sacred traditions
of networkdom, bringing just a bit of fun to an otherwise dry subject. The
goal is to bring the lofty precepts of networking down to earth, where you can
touch them and squeeze them and say, “What’s the big deal? I can do this!”

About This Book

This isn’t the kind of book you pick up and read from start to finish, as if it
were a cheap novel. If | ever see you reading it at the beach, I'll kick sand in
your face. This book is more like a reference, the kind of book you can pick up,
turn to just about any page, and start reading. Each chapter covers a specific
aspect of networking, such as printing from the network, hooking up network
cables, or setting up security so that bad guys can’t break in. Just turn to the
chapter you're interested in and start reading.
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Each chapter is divided into self-contained chunks, all related to the major
theme of the chapter. For example, the chapter on hooking up the network
cable contains nuggets like these:

v What is Ethernet?

v All about cable

v To shield or not to shield
v Wall jacks and patch panels
v Switches

You don’t have to memorize anything in this book. It’s a need-to-know

book: You pick it up when you need to know something. Need to know what
100BaseT is? Pick up the book. Need to know how to create good passwords?
Pick up the book. Otherwise, put it down and get on with your life.

How to Use This Book

This book works like a reference. Start with the topic you want to find out
about. Look for it in the Table of Contents or in the index to get going.

If you need to type something, you see the text you need to type like this:
Type this stuff. In this example, you type Type this stuff at the keyboard and
then press Enter. An explanation usually follows, just in case you're scratching
your head and grunting, “Huh?”

Whenever I describe a message or information that you see on the screen, I
present it this way:

A message from your friendly network

This book rarely directs you elsewhere for information; just about everything
that you need to know about networks is right here. If you find the need for
additional information, plenty of other For Dummies books can help. If you
have a networking question that isn’t covered in this book, allow me to sug-
gest my own Networking All-in-One For Dummies, 5th Edition (Wiley), which

is a much-expanded reference book that goes deeper into specific network
operating systems and TCP/IP protocols. You can also find plenty of other
For Dummies books that cover just about every operating system and appli-
cation program known to humanity.
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What You Don’t Need to Read

Aside from the topics you can use right away, much of this book is skippable.
I carefully placed extra-technical information in self-contained sidebars and
clearly marked them so that you can steer clear of them. Don’t read this stuff
unless you're really into technical explanations and want to know a little of
what’s going on behind the scenes. Don’t worry: My feelings won’t be hurt if
you don’t read every word.

Foolish Assumptions

I’'m making only two assumptions about who you are: You're someone who
works with a PC, and you either have a network or you’re thinking about get-
ting one. [ hope that you know (and are on speaking terms with) someone
who knows more about computers than you do. My goal is to decrease your
reliance on that person, but don’t throw away his phone number yet.

[s this book useful for Macintosh users? Absolutely. Although the bulk of this
book is devoted to showing you how to link Windows-based computers to
form a network, you can find information about how to network Macintosh
computers as well.

Windows 8? Gotcha covered. You'll find plenty of information about how to
network with the latest and greatest Microsoft operating system.

How This Book Is Organized

Inside this book, you find chapters arranged in parts. Each chapter breaks
down into sections that cover various aspects of the chapter’s main subject.
The chapters are in a logical sequence, so reading them in order (if you want
to read the whole thing) makes sense, but the book is modular enough that
you can pick it up and start reading at any point.

Here’s the lowdown on what’s in each part.

Part I: Getting Started with Networking

The chapters in this part present a layperson’s introduction to what networking
is all about. This part is a good place to start if you're clueless about what
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a network is and why you’re suddenly expected to use one. It’s also a great
place to start if you're a hapless network user who doesn’t give a whit about
“optimizing network performance” but wants to know what the network is
and how to get the most out of it.

The best thing about this part is that it focuses on how to use a network with-
out getting into the technical details of setting up a network or maintaining a
network server. In other words, this part is aimed at ordinary network users
who have to know how to get along with a network.

Part II: Setting Up a Network

Uh-oh. The boss just gave you an ultimatum: Get a network up and running
by Friday or pack your things. The chapters in this section cover everything
you need to know to build a network, from picking the network operating
system to installing the cable.

Part I1I: Working with Servers

One of the most challenging aspects of setting up a network is installing and
configuring server computers and the software that runs on them. The chap-
ters in this part show you how to set up a basic server, create user accounts,
and configure file, e-mail, and web servers.

Part IU: Cloudy with a
Chance of Gigabytes

The chapters in this part introduce you to techniques for extending your net-
work into the Internet using what has come to be known as cloud computing.
Included in this part are chapters about integrating the new breed of mobile
devices such as smartphones and tablet computers into your network, as
well as extending your office network to your home computer.

Part U: Managing and Protecting
Your Network

I hope that the job of managing the network doesn’t fall on your shoulders,
but in case it does, the chapters in this part can help you out. You find out all
about backup, security, performance, dusting, mopping, changing the oil, and
all the other stuff that network managers have to do.
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You will also learn about network security: backing up your data, protecting
your network from evil people who want to break your network’s back, and
hardening your network against threats such as viruses and spyware.

Part Ul: More Ways to Network

The three chapters in this part cover some additional technologies you need
to know to build and manage a successful network. First, you’ll see how you
can use virtualization in your network so that you can save money by buying
fewer server computers. Then you’ll discover about networking with the two
most popular alternatives to Windows: Linux and Macintosh computers.

Part Ull: The Part of Tens

This wouldn’t be a For Dummies book without a collection of lists of interest-
ing snippets: ten networking commandments, ten things you should keep in
your closet, and more!

Icons Used in This Book

Those nifty little pictures in the margin aren’t there just to pretty up the
place. They also have practical functions.

Hold it — technical details lurk just around the corner. Read on only if you
have a pocket protector.

Pay special attention to this icon; it lets you know that some particularly
useful tidbit is at hand — perhaps a shortcut or a little-used command that
pays off big.

Did I tell you about the memory course I took?

Danger, Will Robinson! This icon highlights information that may help you
avoid disaster.

5
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Where to Go from Here

Yes, you can get there from here. With this book in hand, you're ready to

plow right through the rugged networking terrain. Browse through the Table

of Contents and decide where you want to start. Be bold! Be courageous! Be
MBER adventurous! Above all, have fun!

Occasionally, we have updates to our technology books. If this book does
have any technical updates, they’ll be posted at

www . dummies.com/go/networkingonlinefdlOeupdates
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In this part...

v Learning what a network is and what you can do with one
v~ Comparing server and client computers

v Accessing network resources such as shared storage and net-
work printers

v Using Microsoft Office and other software on a network
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Chapter 1
Let's Network!

In This Chapter

Getting a handle on networks

Considering why networking is useful (and is everywhere)

Telling the difference between servers and clients

Looking under the hood at the network operating system

Asking “How does it work when a network works if a network works for me?” (Say what?)
Assessing how networks change computing life

Identifying (and offering sympathy to) the network administrator

Comparing servers to clients: What have they got that you don’t got?

‘ omputer networks get a bad rap in the movies. In the classic Terminator

movies, Skynet (a computer network of the future) takes over the planet,
builds deadly terminator robots, and sends them back through time to kill
everyone unfortunate enough to have the name Sarah Connor. In the Matrix
movies, a vast and powerful computer network enslaves humans and keeps
them trapped in a simulation of the real world. And in Eagle Eye, Shia LaBeouf
is chased around the country by a deranged supercomputer that has control
of every imaginable networkable device, including traffic signals, mobile
phones, and fast-food menus.

Fear not. These bad networks exist only in the dreams of science fiction writers.
Real-world networks are much more calm and predictable. They don’t think
for themselves, they can’t evolve into something you don’t want them to be,
and they won’t hurt you, even if your name is Sarah Connor.

Now that you're over your fear of networks, you're ready to breeze through
this chapter. It’s a gentle, even superficial, introduction to computer networks,
with a slant toward the concepts that can help you use a computer that’s
attached to a network. This chapter goes easy on the details; the detailed and
boring stuff comes later.
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Defining a Network

A network is nothing more than two or more computers connected by a cable
or by a wireless radio connection so that they can exchange information.

Of course, computers can exchange information in ways other than networks.
Most of us have used what computer nerds call the sneakernet. That’s where
you copy a file to a flash drive (or a CD or DVD) and then walk the data over
to someone else’s computer. (The term sneakernet is typical of computer
nerds’ feeble attempts at humor.)

The whole problem with the sneakernet is that it’s slow, and it wears a trail in
your carpet. One day, some penny-pinching computer geeks discovered that
connecting computers with cables was cheaper than replacing the carpet
every six months. Thus, the modern computer network was born.

You can create a simple computer network by hooking together all the com-
puters in your office with cables and using the computer’s nefwork interface
(an electronic circuit that resides inside your computer and has a special
jack on the computer’s backside). Then you tweak a few simple settings in
the computer’s operating system (OS) software, and voila! You have a work-
ing network. That’s all there is to it.

If you don’t want to mess with cables, you can create a wireless network
instead. In a wireless network, the computers use wireless network adapt-
ers that communicate via radio signals. All modern laptop computers have
built-in wireless network adapters. To create a wireless network with a desk-
top computer, though, you’ll need to purchase a separate wireless network
adapter that plugs into one of the computer’s USB ports.

Figure 1-1 shows a typical network with four computers. You can see that

all four computers are connected by a network cable to a central network
device: the switch. You can also see that Ward’s computer has a fancy laser
printer attached to it. Because of the network, June, Wally, and the Beaver can
also use this laser printer. (Also, you can see that the Beaver stuck yesterday’s
bubble gum to the back of his computer. Although the bubble gum isn’t
recommended, it shouldn’t adversely affect the network.)
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June's computer Wally's computer

Figure 1-1:

A typical
network.
—— Ward's laser printer

Computer networking has its own strange vocabulary. Although you don’t
have to know every esoteric networking term, it helps to be acquainted with
a few of the basic buzzwords:

»* LAN: Networks are often called LANs, short for local area network.

LAN is the first TLA — or three-letter acronym — of this book. You don’t

really need to remember it or any of the many TLAs that follow. In fact,

the only three-letter acronym you need to remember is TLA. You might
guess that the acronym for four-letter acronym is FLA. Wrong! A four-letter
acronym is an ETLA, which stands for extended three-letter acronym.

After all, it just wouldn’t be right if the acronym for four-letter acronym
had only three letters.

v On the network: Every computer connected to the network is said to
be “on the network.” The technical term (which you can forget) for a
computer that’s on the network is a node.

v+ Online, offline: When a computer is turned on and can access the network,
the computer is online. When a computer can’t access the network, it’s
offline. A computer can be offline for several reasons. The computer can
be turned off, the user may have disabled the network connection, the
computer may be broken, the cable that connects it to the network can
be unplugged, or a wad of gum can be jammed into the disk drive.

v Up, down: When a computer is turned on and working properly, it’s
up. When a computer is turned off, broken, or being serviced, it’s down.

11


http:///

1 2 Part I: Getting Started with Networking

Turning off a computer is sometimes called faking it down. Turning it
back on is sometimes called bringing it up.

+* Local, remote: A resource such as a disk drive is local if it resides in
your computer. It’s remote if it resides in another computer somewhere
else on your network.

v~ Internet: The Internet is a huge amalgamation of computer networks
strewn about the entire planet. Networking the computers in your home
or office so that they can share information with one another and con-
necting your computer to the worldwide Internet are two separate but
related tasks.

Why Bother with a Network?

Frankly, computer networks are a bit of a pain to set up. So why bother? Because
the benefits of having a network outweigh the difficulties of setting up one.

You don’t have to be a PhD to understand the benefits of networking. In fact,
you learned everything you need to know in kindergarten: Networks are all
about sharing. Specifically, networks are about sharing three things: files,
resources, and programs.

Sharing files

Networks enable you to share information with other computers on the net-
work. Depending on how you set up your network, you can share files with
your network friends in several different ways. You can send a file from your
computer directly to a friend’s computer by attaching the file to an e-mail
message and then mailing it. Or you can let your friend access your com-
puter over the network so that your friend can retrieve the file directly from
your hard drive. Yet another method is to copy the file to a disk on another
computer and then tell your friend where you put the file so that your friend
can retrieve it later. One way or the other, the data travels to your friend’s
computer over the network cable and not on a CD or DVD or flash drive, as it
would in a sneakernet.

Sharing resources

You can set up certain computer resources — such as hard drives or printers —
so that all computers on the network can access them. For example, the laser
printer attached to Ward’s computer in Figure 1-1 is a shared resource, which
means that anyone on the network can use it. Without the network, June,
Wally, and the Beaver would have to buy their own laser printers.
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Hard drives can be shared resources, too. In fact, you must set up a hard
drive as a shared resource to share files with other users. Suppose that Wally
wants to share a file with the Beaver, and a shared hard drive has been set
up on June’s computer. All Wally has to do is copy his file to the shared hard
drive in June’s computer and tell the Beaver where he put it. Then, when the
Beaver gets around to it, he can copy the file from June’s computer to his
own (unless, of course, that hooligan Eddie Haskell deletes the file first).

You can share other resources, too, such as an Internet connection. In fact,
sharing an Internet connection is one of the main reasons why many networks
are created.

Sharing programs

Rather than keep separate copies of programs on each person’s computer,
putting programs on a drive that everyone shares is sometimes best. For
example, if ten computer users all use a particular program, you can pur-
chase and install ten copies of the program, one for each computer. Or you
can purchase a ten-user license for the program and then install just one
copy of the program on a shared drive. Each of the ten users can then access
the program from the shared hard drive.

In most cases, however, running a shared copy of a program over the network
is unacceptably slow. A more common way of using a network to share pro-
grams is to copy the program’s installation disks or CDs to a shared network
drive. Then you can use that copy to install a separate copy of the program on
each user’s local hard drive. For example, Microsoft Office enables you to do
this if you purchase a license from Microsoft for each computer on which you
install Office.

The advantage of installing Office from a shared network drive is that you don’t
have to lug around the installation disks or CDs to each user’s computer. And
the system administrator can customize the network installation so that the
software is installed the same way on each user’s computer. (However, these
benefits are significant only for larger networks. If your network has fewer
than about ten computers, you're probably better off installing the program
separately on each computer directly from the installation disks or CDs.)

Remember that purchasing a single-user copy of a program and then putting it
on a shared network drive — so that everyone on the network can access it —
is illegal. If five people use the program, you need to either purchase five copies
of the program or purchase a network license that specifically allows five or
more users.

That being said, many software manufacturers sell their software with a con-
current usage license, which means that you can install the software on as
many computers as you want, but only a certain number of people can use
the software at any given time. Usually, special licensing software that runs on
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one of the network’s server computers keeps track of how many people are
currently using the software. This type of license is frequently used with more
specialized (and expensive) software, such as accounting systems or com-
puter drafting systems.

Another benefit of networking is that networks enable computer users to
communicate with one another over the network. The most obvious way
networks allow computer users to communicate is by passing messages back
and forth, using e-mail or instant-messaging programs. Networks also offer
other ways to communicate: For example, you can hold online meetings over
the network. Network users who have inexpensive video cameras (webcams)
attached to their computers can have videoconferences. You can even play a
friendly game of Hearts over a network — during your lunch break, of course.

Servers and Clients

The network computer that contains the hard drives, printers, and other
resources that are shared with other network computers is a server. This
term comes up repeatedly, so you have to remember it. Write it on the back
of your left hand.

Any computer that’s not a server is a client. You have to remember this term,
too. Write it on the back of your right hand.

Only two kinds of computers are on a network: servers and clients. Look at
your left hand and then look at your right hand. Don’t wash your hands until
you memorize these terms.

The distinction between servers and clients in a network has parallels in
sociology — in effect, a sort of class distinction between the “haves” and
“have-nots” of computer resources:

v Usually, the most powerful and expensive computers in a network are
the servers. There’s a good technical reason: All users on the network
share the server’s resources.

v The cheaper and less-powerful computers in a network are the clients.
Clients are the computers used by individual users for everyday work.
Because clients’ resources don’t have to be shared, they don’t have to
be as fancy.

1 Most networks have more clients than servers. For example, a network
with ten clients can probably get by with one server.

v In many networks, a clean line of demarcation exists between servers
and clients. In other words, a computer functions as either a server or
a client, not both. For the sake of an efficient network, a server can’t
become a client, nor can a client become a server.


http:///

Chapter 1: Let's Network!

v Other (usually smaller) networks can be more evenhanded by allowing
any computer in the network to be a server and allowing any computer
to be both server and client at the same time.

Dedicated Servers and Peers

WBER
@&
&

In some networks, a server computer is a server computer and nothing else.
It’s dedicated to the sole task of providing shared resources, such as hard
drives and printers, to be accessed by the network client computers. This
type of server is a dedicated server because it can perform no other task than
network services.

Some smaller networks take an alternative approach by enabling any com-
puter on the network to function as both a client and a server. Thus, any
computer can share its printers and hard drives with other computers on the
network. And while a computer is working as a server, you can still use that
same computer for other functions, such as word processing. This type of
network is a peer-to-peer network because all the computers are thought of as
peers, or equals.

Here are some points to ponder concerning the differences between dedi-
cated server networks and peer-to-peer networks while you're walking the
dog tomorrow morning:

v Peer-to-peer networking features are built into Windows. Thus, if your
computer runs Windows, you don’t have to buy any additional software
to turn your computer into a server. All you have to do is enable the
Windows server features.

v The network server features that are built into desktop versions of
Windows (such as Windows 7 and 8) aren’t particularly efficient because
these versions of Windows weren’t designed primarily to be network
servers.

If you dedicate a computer to the task of being a full-time server, use a
special network operating system rather than the standard Windows
operating system. A network operating system (NOS) is specially
designed to handle networking functions efficiently.

* The most commonly used NOSes are the server versions of Windows.

As of this writing, the current server version of Windows is
Windows Server 20012. However, many companies still use the
previous version (Windows Server 2008), and a few even use its
predecessor, Windows 2003 Server.

¢ Another popular NOS is Linux. Linux is popular because it is free.
However, it requires a more expertise to set up than Windows Server.
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v Many networks are both peer-to-peer and dedicated-server networks at
the same time. These networks have

¢ At least one server computer that runs an NOS, such as Windows
Server 2012

¢ Client computers that use the server features of Windows to share
their resources with the network

1 Besides being dedicated, your servers should also be sincere.

What Makes a Network Tick?

\\3

To use a network, you don’t really have to know much about how it works.
Still, you may feel a little bit better about using the network if you realize that
it doesn’t work by voodoo. A network may seem like magic, but it isn’t. The
following list describes the inner workings of a typical network:

+* Network interface: Inside any computer attached to a network is a spe-
cial electronic circuit called the network interface. The network interface
has either an external jack into which you can plug a network cable —
or, in the case of a wireless network interface, an antenna.

1 Network cable: The network cable physically connects the computers. It
plugs into the network interface card (NIC) on the back of your computer.

The type of network cable most commonly used is twisted-pair cable, so
named because it consists of several pairs of wires twisted together in a
certain way. Twisted-pair cable superficially resembles telephone cable.
However, appearances can be deceiving. Most phone systems are wired
using a lower grade of cable that doesn’t work for networks.

For the complete lowdown on networking cables, see Chapter 6.

Network cable isn’t necessary when wireless networking is used. For
more information about wireless networking, see Chapter 9.

1 Network switch: Networks built with twisted-pair cabling require one
or more switches. A switch is a box with a bunch of cable connectors.
Each computer on the network is connected by cable to the switch. The
switch, in turn, connects all the computers to each other.

In the early days of twisted-pair networking, devices known as hubs were
used rather than switches. The term hub is sometimes used to refer to
switches, but true hubs went out of style sometime around the turn of
the century.

In networks with just a few computers, the network switch is often com-
bined with another networking device called a router. A router is used to
connect two networks. Typically, a router is used to connect your network
to the Internet. By combining a router and a switch in a single box, you
can easily connect several computers to the Internet and to each other.
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1 Network software: Of course, the software makes the network work.
To make any network work, a whole bunch of software has to be set up
just right. For peer-to-peer networking with Windows, you have to play
with the Control Panel to get networking to work. And an NOS such as
Windows Server 2012 requires a substantial amount of tweaking to get it
to work just right.

It’s Not a Personal Computer Anymore!

If I had to choose one point that I want you to remember from this chapter
more than anything else, it’s this: After you hook up your personal computer
(PC) to a network, it’s not a “personal” computer anymore. You're now part
of a network of computers, and in a way, you’ve given up one of the key con-
cepts that made PCs so successful in the first place: independence.

I got my start in computers back in the days when mainframe computers
ruled the roost. Mainframe computers are big, complex machines that used to
fill entire rooms and had to be cooled with chilled water. My first computer
was a water-cooled Binford Hex Core Model 2000. Argh, argh, argh. (I'm not
making up the part about the water. A plumber was often required to install a
mainframe computer. In fact, the really big ones were cooled by liquid nitrogen.
[ am making up the part about the Binford 2000.)

Mainframe computers required staffs of programmers and operators in white
lab coats just to keep them going. The mainframes had to be carefully managed.
A whole bureaucracy grew up around managing them.

Mainframe computers used to be the dominant computers in the workplace.
Personal computers changed all that: They took the computing power out
of the big computer room and put it on the user’s desktop, where it belongs.
PCs severed the tie to the centralized control of the mainframe computer.
With a PC, a user could look at the computer and say, “This is mine — all
mine!” Mainframes still exist, but they’re not nearly as popular as they once
were.

But networks have changed everything all over again. In a way, it’s a change
back to the mainframe-computer way of thinking: central location, distrib-
uted resources. True, the network isn’t housed in the basement and doesn’t
have to be installed by a plumber. But you can no longer think of “your” PC
as your own. You're part of a network — and like the mainframe, the network
has to be carefully managed.

Here are several ways in which a network robs you of your independence:

 You can’t just indiscriminately delete files from the network. They
may not be yours.
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” You're forced to be concerned about network security. For example, a
server computer has to know who you are before it allows you to access
its files. So you have to know your user ID and password to access the
network. This precaution prevents some 15-year-old kid from hacking
his way into your office network by using its Internet connection and
stealing all your computer games.

+* You may have to wait for shared resources. Just because Wally sends
something to Ward’s printer doesn’t mean that it immediately starts to
print. The Beav may have sent a two-hour print job before that. Wally
just has to wait.

+ You may have to wait for access to documents. You may try to retrieve
an Excel spreadsheet file from a network drive, only to discover that
someone else is using it. Like Wally, you just have to wait.

* You don’t have unlimited storage space. If you copy a 100GB video file
to a server’s drive, you may get calls later from angry co-workers com-
plaining that no room is left on the server’s drive for their important files.

+ Your files can become infected from viruses given to you by someone
over the network. You may then accidentally infect other network users.

+* You have to be careful about saving sensitive files on the server. If you
write an angry note about your boss and save it on the server’s hard
drive, your boss may find the memo and read it.

v The server computer must be up and running at all times. For example,
if you turn Ward’s computer into a server computer, Ward can’t turn his
computer off when he’s out of the office. If he does, you can’t access the
files stored on his computer.

v~ If your computer is a server, you can’t just turn it off when you’re
finished using it. Someone else may be accessing a file on your hard
drive or printing on your printer.

The Network Administrator

Because so much can go wrong — even with a simple network — designating
one person as network administrator is important. This way, someone is
responsible for making sure that the network doesn’t fall apart or get out of
control.

The network administrator doesn’t have to be a technical genius. In fact,
some of the best network administrators are complete idiots when it comes
to technical stuff. What’s important is that the administrator is organized.
That person’s job is to make sure that plenty of space is available on the file
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server, that the file server is backed up regularly, that new employees can
access the network, among other tasks.

The network administrator’s job also includes solving basic problems that
the users themselves can’t solve — and knowing when to call in an expert
when something really bad happens. It’s a tough job, but somebody’s got to
do it. Here are a few tips that might help:

v Part V of this book is devoted entirely to the hapless network adminis-
trator. So if you're nominated, read the chapters in that part. If you're
lucky enough that someone else is nominated, celebrate by buying her a
copy of this book.

v In small companies, picking the network administrator by drawing
straws is common. The person who draws the shortest straw loses and
becomes administrator.

v Of course, the network administrator can’t be a complete technical idiot.
I was lying about that. (For those of you in Congress, the word is festify-
ing.) | exaggerated to make the point that organizational skills are more
important than technical skills. The network administrator needs to
know how to do various maintenance tasks. Although this knowledge
requires at least a little technical know-how, the organizational skills are
more important.

What Have They Got That You Don’t Got?

With all this technical stuff to worry about, you may begin to wonder whether
you're smart enough to use your computer after it’s attached to the network.
Let me assure you that you are. If you're smart enough to buy this book
because you know that you need a network, you’re more than smart enough
to use the network after it’s put in. You're also smart enough to install and
manage a network yourself. It isn’t rocket science.

I know people who use networks all the time. They’re no smarter than you
are, but they do have one thing that you don’t have: a certificate. And so,
by the powers vested in me by the International Society for the Computer
Impaired, I present you with the certificate in Figure 1-2, confirming that
you've earned the coveted title Certified Network Dummy, better known as
CND. This title is considered much more prestigious in certain circles than
the more stodgy CNE or MCSE badges worn by real network experts.

Congratulations, and go in peace.

19


http:///

20 Part I: Getting Started with Networking

|
Figure 1-2:
Your official
CND
certificate.
|

Certificate of Network Dumminess

This certifies that

has ascended to the Holy Order of
CERTIFIED NETWORK DUMMY
and is hereby entitled to
all the rights and privileges therein,
headaches and frustrations hitherto,
and Pizza and Jolt Cola wherever.
So let it be written, so let it be done.

Official
CND

Insignia Doug Lowe
Chairman, International Society of Certified

Network Dummies
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Life on the Network

In This Chapter

Using local resources and network resources
Playing the name game

Logging on to a network

Using shared folders

Going places with networks

Mapping your network drives

Using a network printer

Logging off the network

A fter you hook up your PC to a network, it’s not an island anymore, sepa-
rated from the rest of the world like some kind of isolationist fanatic
waving a “Don’t tread on me” flag. The network connection changes your PC
forever. Now your computer is part of a system, connected to other computers
on the network. You have to worry about annoying network details, such as
using local and shared resources, logging on and accessing network drives,
using network printers, logging off, and who knows what else.

Oh, bother.

This chapter brings you up to speed on what living with a computer network
is like. Unfortunately, this chapter gets a little technical at times, so you may
need your pocket protector.

Distinguishing between Local Resources
and Network Resources

In case you don’t catch this statement in Chapter 1, one of the most important
differences between using an isolated computer and using a network com-
puter lies in the distinction between local resources and network resources.
Local resources are items — such as hard drives, printers, and CD or DVD
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drives — that are connected directly to your computer. You can use

local resources whether you’re connected to the network or not. Network
resources, on the other hand, are the hard drives, printers, optical drives, and
other devices that are connected to the network’s server computers. You can
use network resources only after your computer is connected to the network.

Whenever you use a computer network, you need to know which resources
are local resources (belong to you) and which are network resources (belong
to the network). In most networks, your C: drive is a local drive, as is your My
Documents folder. If a printer is sitting next to your PC, it’s probably a local
printer. You can do anything you want with these resources without affecting
the network or other users on the network (as long as the local resources
aren’t shared on the network). Keep these points in mind:

» You can'’t tell just by looking at a resource whether it’s a local resource
or a network resource. The printer that sits right next to your com-
puter is probably your local printer, but then again, it may be a network
printer. The same statement is true for hard drives: The hard drive in
your PC is probably your own, but it (or part of it) may be shared on the
network, thus enabling other users to access it.

v Because dedicated network servers are full of resources, you may say
that they’re not only dedicated (and sincere), but also resourceful.
(Groan. Sorry. This is yet another in a tireless series of bad computer-
nerd puns.)

What's in a Name?

Just about everything on a computer network has a name: The computers
themselves have names, the people who use the computers have names, the
hard drives and printers that can be shared on the network have names, and
the network itself has a name. Knowing all the names used on your network
isn’t essential, but you do need to know some of them.

Here are some additional details about network names:

v+ Every person who can use the network has a username (sometimes
called a user ID). You need to know your username to log on to the net-
work. You also need to know the usernames of your buddies, especially
if you want to steal their files or send them nasty notes.

You can find more information about usernames and logging on in the
section “Logging On to the Network,” later in this chapter.

QNING/ 1~ Letting folks on the network use their first names as their usernames

¥ is tempting but not a good idea. Even in a small office, you eventually
run into a conflict. (And what about Mrs. McCave — made famous by Dr.
Seuss — who had 23 children and named them all Dave?)
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Create a consistent way of creating usernames. For example, you may
use your first name plus the first two letters of your last name. Then
Wally’s username is wallycl, and Beaver’s is beavercl. Or you may
use the first letter of your first name followed by your complete last
name. Then Wally’s username is wcleaver, and Beaver’s is bcleaver.
(In most networks, capitalization doesn’t matter in usernames. Thus,
bcleaver is the same as BCleaver.)

v Every computer on the network must have a unique computer name.

You don’t have to know the names of all the computers on the network,
but it helps if you know your own computer’s name and the names of
any server computers you need to access.

The computer’s name is sometimes the same as the username of the person
who uses the computer, but that’s usually a bad idea because in many com-
panies, people come and go more often than computers. Sometimes the
names indicate the physical location of the computer, such as office-12
or back-room. Server computers often have names that reflect the group
that uses the server most, like acctng-server or cad-server.

Some network nerds like to assign techie-sounding names, like BL3K5-
87a. And some like to use names from science fiction movies; HAL,
Colossus, M5, and Data come to mind. Cute names like Herbie aren’t
allowed. (However, Tigger and Pooh are entirely acceptable — recom-
mended, in fact. Networks are what Tiggers like the best.)

Usually, the sensible approach to computer naming is to use names that
have numbers, such as computer001 or computer002.

1 Network resources, such as shared disk folders and printers, have
names. For example, a network server may have two printers, named
laser and inkjet (to indicate the type of printer), and two shared disk
folders, named AccountingData and MarketingData.

1 Server-based networks have a username for the network administrator.

If you log on using the administrator’s username, you can do anything
you want: add new users, define new network resources, change Wally’s
password, anything. The administrator’s username is usually something
clever such as Administrator.

v The network itself has a name.
The Windows world has two basic types of networks:

® Domain networks are the norm for large corporate environments
that have dedicated servers with IT staff to maintain them.

e Workgroup networks are more common in homes or in small offices
that don’t have dedicated servers or IT staff.

A domain network is known by — you guessed it — a domain name. And
a workgroup network is identified by — drum roll, please — a workgroup
name. Regardless of which type of network you use, you need to know
this name to gain access to the network.
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Logging On to the Network
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|
Figure 2-1:
Logging

into a
Windows 8
system.
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To use network resources, you must connect your computer to the network,
and you must go through the supersecret process of logging on, which is how
you let the network know who you are so that it can decide whether you're
one of the good guys.

Logging on is a little bit like cashing a check. You must have two forms of
identification:

v Your username: The name by which the network knows you.

Your username is usually some variation of your real name, like Beav for
the Beaver.

Everyone who uses the network must have a username.

v Your password: A secret word that only you and the network know. If you
type the correct password, the network believes that you are who you
say you are.

Every user has a different password, and the password should be a secret.

In the early days of computer networking, you had to type a logon command
at a stark MS-DOS prompt and then supply your user ID and password.
Nowadays, the glory of Windows is that you get to log on to the network
through a special network logon screen. Figure 2-1 shows the Windows 8
version of this dialog box.

Doug Lowe
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Here are some more logon points to ponder:

v The terms user ID and logon name are sometimes used instead of user-
name. They all mean the same thing.

v As long as we're talking about words that mean the same thing, log in
and log on mean the same thing, as do (respectively) log out and log off
as ways of saying, “I'm outta here.” Although you see both out there in
the world, this book uses log on and log off throughout — and if there’s
any exception, the book says why and grouses about it a bit.

v As far as the network’s concerned, you and your computer aren’t the
same thing. Your username refers to you, not to your computer. That’s
why you have a username and your computer has a computer name.
You can log on to the network by using your username from any com-
puter that’s attached to the network. Other users can log on at your
computer by using their own usernames.

When others log on at your computer by using their own usernames,
they can’t access any of your network files that are protected by your
password. However, they can access any local files that you haven'’t pro-
tected. Be careful which people you allow to use your computer.

v If you're logging on to a domain network on a Windows Vista, Windows
7, or Windows 8 computer, you must type the domain name before your
username, separated from it by a backslash. For example:

lowewriter\dlowe
Here, the domain name is lowewriter, and the username is dlowe.

Note that Windows remembers the domain and username from your last
login, so ordinarily all you have to enter is your password. To log on to a
different domain or as a different user, you must click Switch User. Then
you can click the Other User icon and enter a different domain name and
username, along with the password for the user you want to log on as.

+* On an older Windows XP system, the logon dialog box has a field in
which you can enter the domain name you want to log on to.

v Your computer may be set up so that it logs you on automatically when-
ever you turn it on. In that case, you don’t have to type your username
and password. This setup makes the task of logging on more convenient
but takes the sport out of it. And it’s a terrible idea if you're the least bit
worried about bad guys getting into your network or personal files.

v Guard your password with your life. I'd tell you mine, but then I'd have
to shoot you.
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Understanding Shared Folders
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Long ago, in the days Before Network (B.N.), your computer probably had
just one hard drive, known as the C: drive. Maybe it had two — C: and D:.
The second drive might be another hard disk, or possibly a CD-ROM or DVD-
ROM drive. Even to this day, the descendants of those drives are physically
located inside your PC. They’re your local drives.

Now that you're on a network, however, you may have access to drives that
aren’t located inside your PC but are located instead in one of the other com-
puters on the network. These network drives can be located on a dedicated
server computer or, in the case of a peer-to-peer network, on another client
computer.

In some cases, you can access an entire network drive over the network. But in
most cases, you can’t access the entire drive. Instead, you can access only
certain folders on the network drives. Either way, the shared drives or folders
are known in Windows terminology as shared folders.

Here’s where it gets confusing: The most common way to access a shared
folder is to assign a drive letter to it. Suppose that a server has a shared folder
named Marketing. You can assign drive letter M to this shared folder. Then
you access the Marketing folder as drive M:. The M: drive is then called a
network drive because it uses the network to access data in a shared folder.
Assigning a drive letter to a shared folder is mapping a drive.

Shared folders can be set up with restrictions on how you can use them. For
example, you may be granted full access to some shared folders so that you
can copy files to or from them, delete files on them, or create or remove fold-
ers on them. On other shared folders, your access may be limited in certain
ways. For example, you may be able to copy files to or from the shared folder
but not delete files, edit files, or create new folders. You may also be asked
to enter a password before you can access a protected folder. The amount of
disk space you're allowed to use on a shared folder may also be limited. For
more information about file-sharing restrictions, see Chapter 12.

In addition to accessing shared folders that reside on other people’s comput-
ers, you can designate your computer as a server to enable other network
users to access folders that you share. To find out how to share folders on
your computer with other network users, see Chapter 3.

Four Good Uses for a Shared Folder

After you know which shared network folders are available, you may wonder
what you're supposed to do with them. This section describes four good uses
for a network folder.
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Store files that everybody needs

A shared network folder is a good place to store files that more than one
user needs to access. Without a network, you have to store a copy of the file
on everyone’s computer, and you have to worry about keeping the copies
synchronized (which you can’t do, no matter how hard you try). Or you can
keep the file on a disk and pass it around. Or you can keep the file on one
computer and play Musical Chairs; whenever someone needs to use the file,
he goes to the computer that contains the file.

On a network, you can keep one copy of the file in a shared folder on the
network, and everyone can access it.

Store your own files

You can also use a shared network folder as an extension of your own hard
drive storage. For example, if you filled up all the free space on your hard drive
with pictures, sounds, and movies that you downloaded from the Internet,
but the network server has billions and billions of gigabytes of free space,
you have all the drive space you need. Just store your files on the network
drive!

Here are a few guidelines for storing files on network drives:

+” Using the network drive for your own files works best if the network
drive is set up for private storage that other users can’t access. That
way, you don’t have to worry about the nosy guy down in Accounting
who likes to poke around in other people’s files.

+ Don’t overuse the network drive. Remember that other users have
probably filled up their own hard drives, so they want to use the space
on the network drive too.

+* Before you store personal files on a network drive, make sure that you
have permission. A note from your mom will do.

+* On domain networks, a drive (typically, drive H:) is commonly mapped
to a user’s home folder. The home folder is a network folder that’s unique
for each user. You can think of it as a network version of My Documents.
If your network is set up with a home folder, use it rather than My
Documents for any important work-related files. That’s because the home
folder is usually included in the network’s daily backup schedule. By con-
trast, most networks do not back up data you store in My Documents.


http:///

28

Part I: Getting Started with Networking

A\

Make a temporary resting place for
files on their way to other users

“Hey, Wally, could you send me a copy of last month’s baseball stats?”

“Sure, Beav.” But how? If the baseball stats file resides on Wally’s local drive,
how does Wally send a copy of the file to Beaver’s computer? Wally can do
it by copying the file to a network drive. Then Beaver can copy the file to his
local hard drive.

Here are some tips to keep in mind when you use a network drive to
exchange files with other network users:

+ Remember to delete files that you saved to the network drive after
they’re picked up! Otherwise, the network drive quickly fills up with
unnecessary files.

1 Create a folder on the network drive specifically intended for holding
files en route to other users. I like to name this folder PITSTOP.

In many cases, it’s easier to send files to other network users by e-mail than
by using a network folder. Just send a message to the other network user and
attach the file you want to share. The advantage of sending a file by e-mail is
that you don’t have to worry about details like where to leave the file on the
server and who'’s responsible for deleting the file.

Back up your local hard drive

If enough drive space is available on the file server, you can use it to store
backup copies of the files on your hard drive. Just copy the files that you
want to back up to a shared network folder.

Obviously, if you copy all your data files to the network drive — and every-
body else follows suit — it can fill up quickly. Check with the network man-
ager before you start storing backup copies of your files on the server. The
manager may have already set up a special network drive that’s designed just
for backups. And if you're lucky, your network manager may be able to set up
an automatic backup schedule for your important data so that you don’t have
to remember to back it up manually.

vww . allitebooks.cond
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[ hope that your network administrator also routinely backs up the contents
of the network server’s disk to tape. (Yes, tape — see Chapter 20 for details.)
That way, if something happens to the network server, the data can be recov-
ered from the backup tapes.

Oh, the Network Places Vou'll Go

|
Figure 2-2:
Browsing
the network
in

Windows 8.
|

Windows enables you to access network resources, such as shared folders,
by browsing the network. In Windows XP, you do this by double-clicking
the My Network Places icon that resides on your desktop. In Windows
Vista and Windows 7, choose Network from the Start menu. In Windows 8,
open Windows Explorer (click File Explorer on the taskbar) and then click
Network. Figure 2-2 shows the Windows 8 version of the network browser.
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The network shown in Figure 2-2 consists of 45 computers, with names
such as BCFCOM1, BCFFS03, and so on. You can open one of the computers
by double-clicking its icon to reveal a list of shared resources available on
the computer. For example, Figure 2-3 shows the resources shared by the
BCFFS03 computer.
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You can also browse the network from any Windows application program.
For example, you may be working with Microsoft Word 2010 and want to
open a document file that’s stored in a shared folder on your network. All you
have to do is use the Open command to bring up the dialog box. (In Office
2003 and 2010, this command is on the File menu. In Office 2007, you'll find it
by clicking the Office button.) Choose Network in the list that appears in the
pane on the left of the Open dialog box to browse the network, as shown in

Figure 2-4.
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Mapping Network Drives

<P If you often access a particular shared folder, you may want to use the special
trick known as mapping to access the shared folder more efficiently. Mapping
assigns a drive letter to a shared folder. Then you can use the drive letter
to access the shared folder as though it were a local drive. In this way, you
can access the shared folder from any Windows program without having to
browse the network.

For example, you can map a shared folder named Data on the server named
SERVERO1 Files to drive K: on your computer. Then, to access files stored in
the shared Data folder, you look on drive K.

To map a shared folder to a drive letter, follow these steps:

1. Open File Explorer.
e Windows Vista or 7: Choose Start>Computer.

e Windows 8: Open the desktop and click the File Explorer icon on
the taskbar, and then click Computer in the Location list on the left
side of the screen.

2. Open the Map Network Drive dialog box.

e Windows Vista and 7: Access this dialog by clicking the Map
Network Drive button located on the toolbar.

e Windows 8: Click Map Network Drive on the ribbon.

Figure 2-5 shows the Map Network Drive dialog box for Windows 8. The
dialog box for earlier versions of Windows is similar.

e =

What network folder would you like to map?

Specify the drive letter for the connection and the folder that you want to connect to:

Drive: R: W

Folder: | A4 Browse...

Example: Viserver\share

[¥] Reconnect at sign-in

I [JConnect using different credentials

Connect to 3 Web site that you can use to store your documents and pictures.

Figure 2-5:
The Map
Network

Drive dialog
box. Finish Cancel
1 (|
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3. (Optional) Change the drive letter in the Drive drop-down list.

You probably don’t have to change the drive letter that Windows selects
(in Figure 2-5, drive R). If you're picky, though, you can select the drive
letter from the Drive drop-down list.

4. Click the Browse button.

This step summons the dialog box shown in Figure 2-6.

Select a shared netwark folder
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> |8 BCFEX03

4 |8 BCFFS03

' Agency

B Ao

o AutolISP
AxiumData

Make New Folder Cancel

5. Use the Browse for Folder dialog box to find and select the shared

folder you want to use.

You can navigate to any shared folder on any computer in the network.

. Click OK.

The Browse for Folder dialog box is dismissed, and you return to the
Map Network Drive dialog box (refer to Figure 2-5).

. (Optional) If you want this network drive to be automatically mapped

each time you log on to the network, select the Reconnect at Sign-in
check box.

If you leave the Reconnect at Logon check box deselected, the drive
letter is available only until you shut down Windows or log out of the
network. If you select this option, the network drive reconnects auto-
matically each time you log on to the network.

Be sure to select the Reconnect at Logon check box if you use the net-
work drive often.

. Click OK.

You return to the Computer window, as shown in Figure 2-7. Here, you
can see the newly mapped network drive.
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Your network administrator may have already set up your computer with
one or more mapped network drives. If so, you can ask her to tell you which
network drives have been mapped. Or you can just open the Computer folder

(My Computer on Windows XP) and have a look.

Here are a few additional tips:

v If you’re using Windows XP, the procedure for mapping a network
drive is similar to the one for Windows Vista. Start by opening My
Computer and choosing ToolstoMap Network Drive. Then follow the

preceding set of steps, starting at Step 3.

1 Assigning a drive letter to a network drive is called mapping the
drive, or linking the drive, by network nerds. “Drive Q: is mapped to a

network drive,” they say.

1 Network drive letters don’t have to be assigned the same way for
every computer on the network. For example, a network drive that’s
assigned drive letter M on your computer may be assigned drive letter
Z on someone else’s computer. In that case, your drive M: and the other
computer’s drive Z: refer to the same data. This arrangement can be
confusing. If your network is set up this way, put pepper in your network

administrator’s coffee.

1 Accessing a shared network folder through a mapped network drive is
much faster than accessing the same folder by browsing the network.
Windows has to browse the entire network to list all available computers
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whenever you browse the network. By contrast, Windows doesn’t have
to browse the network to access a mapped network drive.

v If you select the Reconnect at Logon option for a mapped drive (refer
to Figure 2-5), you receive a warning message if the drive isn’t available
when you log on. In most cases, the problem is that the server computer
isn’t turned on. Sometimes, however, this message is caused by a broken
network connection. For more information about fixing network problems
such as this one, see Chapter 19.

Using a Network Printer

Using a network printer is much like using a network hard drive: You can
print to a network printer from any Windows program by choosing the Print
command to call up a Print dialog box from any program and choosing a net-
work printer from the list of available printers. In Office 2003 and 2010, this
command is on the File menu. In Office 2007, you can reach it by clicking the
Office button.

Keep in mind, however, that printing on a network printer isn’t exactly the
same as printing on a local printer; you have to take turns. When you print
on a local printer, you're the only one using it. When you print to a network
printer, however, you are (in effect) standing in line behind other network
users, waiting to share the printer. This line complicates the situation in
several ways:

v~ If several users print to the network printer at the same time, the net-
work has to keep the print jobs separate from one another. If it didn't,
the result would be a jumbled mess, with your 268-page report getting
mixed in with the payroll checks. That would be bad. Fortunately, the
network takes care of this situation by using the fancy print spooling
feature.

+* Network printing works on a first-come, first-served basis (unless you
know some of the tricks that I discuss in Chapter 3). Invariably, when
I get in line at the hardware store, the person in front of me is trying to
buy something that doesn’t have a product code on it. I end up standing
there for hours waiting for someone in Plumbing to pick up the phone
for a price check. Network printing can be like that. If someone sends a
two-hour print job to the printer before you send your half-page memo,
you have to wait.

+* You may have access to a local printer and several network printers.
Before you were forced to use the network, your computer probably had
just one printer attached to it. You may want to print some documents
on your cheap (oops, [ mean local) inkjet printer but use the network
laser printer for important stuff. To do that, you have to find out how to
use your programs’ functions for switching printers.
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Adding a network printer

Before you can print to a network printer, you have to configure your computer
to access the network printer that you want to use. From the Start menu, open
the Control Panel and then double-click the Printers icon. If your computer
is already configured to work with a network printer, an icon for the network
printer appears in the Printers folder. You can tell a network printer from a
local printer by the shape of the printer icon. Network printer icons have a
pipe attached to the bottom of the printer.

If you don’t have a network printer configured for your computer, you can
add one by using the Add Printer Wizard. Just follow these steps:
1. Open the Control Panel.
e Windows 7 or earlier: Choose Start=>Control Panel.

e Windows 8: Press the Windows key, type Control, and then click
the Control Panel icon.

2. Click Devices and Printers.
3. Click the Add a Printer button on the toolbar.

This step starts the Add Printer Wizard, as shown in Figure 2-8.
4. Click the printer you want to use.

If you can’t find the printer you want to use, ask your network administrator
for the printer’s UNC path, which is the name used to identify the printer
on the network, or its IP address. Then click The Printer That I Want Isn’t
Listed and enter the UNC or IP address for the printer when prompted.

o !;!

Select a printer

Printer Name Address

@TBOD-PS on BCFPRTON
!-! HP Laserlet 5000 Series PCL on BCFZACCTNG

T r—

# The printer that | want isn't listed

Cancel
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5. Click Next to add the printer.

The wizard copies to your computer the correct printer driver for the
network printer. (You may be prompted to confirm that you want to add
the driver. If so, click Install Driver to proceed.)

The Add Printer Wizard displays a screen that shows the printer’s name
and asks whether you want to designate the printer as your default printer.

6. (Optional) Designate the printer as your default printer.
7. Click Next to continue.

A final confirmation dialog box is displayed.
8. Click Finish.

You're done!

Many network printers, especially newer ones, are connected directly to the
network by using a built-in Ethernet card. Setting up these printers can be
tricky. You may need to ask the network administrator for help in setting up
this type of printer. (Some printers that are connected directly to the network
have their own web addresses, such as Printer.CleaverFamily.com. If
that’s the case, you can often set up the printer in a click or two: Use your
browser to go to the printer’s web page and then click a link that enables you
to install the printer.)

Printing to a network printer

After you install the network printer in Windows, printing to the network
printer is a snap. You can print to the network printer from any Windows
program by using the Print command to summon the Print dialog box,
which is usually found on the File menu. For example, Figure 2-9 shows the
Print dialog box for WordPad (the free text-editing program that comes with
Windows). The available printers are listed near the top of this dialog box.
Choose the network printer from this list and then click OK to print your
document. That’s all there is to it!

Playing with the print queue

After you send your document to a network printer, you usually don’t have
to worry about it. You just go to the network printer, and voila! Your printed
document is waiting for you.
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That’s what happens in the ideal world. In the real world, where you and I
live, all sorts of things can happen to your print job between the time you
send it to the network printer and the time it prints:

v You discover that someone else already sent a 50 trillion—-page report
ahead of you that isn’t expected to finish printing until the national debt

is paid off.

v The price of a framis valve suddenly goes up by $2, rendering foolish the
recommendations you made in your report.

» Your boss calls and tells you that his brother-in-law will be attending
the meeting, so won’t you please print an extra copy of the proposal for
him? Oh, and a photocopy won’t do. Originals only, please.

»* You decide to take lunch, so you don’t want the output to print until you
get back.

Fortunately, your print job isn’t totally beyond your control just because
you already sent it to the network printer. You can easily change the status
of jobs that you already sent. You can change the order in which jobs print,
hold a job so that it doesn’t print until you say so, or cancel a job.

You can probably make your network print jobs do other tricks, too: shake
hands, roll over, and play dead. But the basic tricks — hold, cancel, and
change the print order — are enough to get you started.

To play with the printer queue, open the Control Panel by choosing Starte>
Control Panel in Windows 7 or earlier; or press the Windows key, type
Control, and the click the Control Panel icon. Then click Devices and Printers
and double-click the icon for the printer that you want to manage. A window
similar to the one shown in Figure 2-10 appears. You can see that just one
document has been sent to the printer.

37
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To manipulate the print jobs that appear in the print queue or in the printer
itself, use these tricks:

+ To temporarily stop a job from printing: Select the job and choose
Document=>Pause Printing. Choose the same command again to release
the job from its state of frustration and print it out, already.

1 To delete a print job: Select the job and choose Document=>Cancel
Printing.

v To stop the printer: Choose Printer=>Pause Printing. To resume, choose
the command again.

v To delete all print jobs: Choose Printer=>Purge Print Documents.

+* To cut to the front of the line: Drag to the top of the list the print job
that you want to print.

All these tips apply to your print jobs only. Unfortunately, you can’t capri-
ciously delete other people’s print jobs.

The best thing about Windows printer management is that it shelters you
from the details of working with different network operating systems.
Whether you print on a NetWare printer, a Windows 2003 network printer, or
a shared Windows printer, the Printer window icon manages all print jobs in
the same way.

Logging Off the Network

After you finish using the network, log off. Logging off the network makes the
network drives and printers unavailable. Your computer is still physically
connected to the network (unless you cut the network cable with pruning
shears; it’s a bad idea — don’t do it!), but the network and its resources are
unavailable to you.

vww.allitebooks.cond



http:///
http://www.allitebooks.org

Chapter 2: Life on the Network 39

WMBER
‘x&
&

Here are a few other tips to keep in mind when you log off:

v After you turn off your computer, you're automatically logged off the
network. After you start your computer, you have to log on again.

Logging off the network is a good idea if you're going to leave your
computer unattended for a while. As long as your computer is logged in
to the network, anyone can use it to access the network. And because
unauthorized users can access it under your user ID, you get the blame
for any damage they do.

v In Windows, you can log off the network by clicking the Start button and
choosing the Log Off command. This process logs you off the network
without restarting Windows:

e In Windows XP: You can reach this command directly from the
Start menu.

¢ In Windows Vista or 7: Click Start and then click the right-facing
arrow that appears next to the little padlock icon.

¢ In Windows 8: Press Ctrl+Alt+Del and then choose Sign Out.
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Chapter 3
More Ways to Use Your Network

In This Chapter

Transforming your computer into a network server
Sharing folders with network users

Working in the Public folder

Sharing your printer

Using Office on a network

Working with files offline

‘ hapter 2 introduces you to the basics of using a network: logging on,

accessing data on shared network folders, printing, and logging off. In
this chapter, I go beyond these basics. You find out how to turn your com-
puter into a server that shares its own files and printers, how to use one of
the most popular network computer applications — e-mail — and how to
work with Office on a network.

Sharing Your Stuff

As you probably know, networks consist of two types of computers: client
computers and server computers. In the economy of computer networks,
client computers are the consumers — the ones that use network resources,
such as shared printers and disk drives. Servers are the providers — the ones
that offer their own printers and hard drives to the network so that the client
computers can use them.

This chapter shows you how to turn your humble Windows client computer
into a server computer so that other computers on your network can use
your printer and any folders that you decide you want to share. In effect,
your computer functions as both a client and a server at the same time. A
couple of examples show how:
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v It’s a client when you send a print job to a network printer or when you
access a file stored on another server’s hard drive.

v It’s a server when someone else sends a print job to your printer or
accesses a file stored on your computer’s hard drive.

Enabling File and Printer
Sharing (Windows XP)

Before you can share your files or your printer with other network users, you
must set up a Windows File and Printer Sharing feature. Without this feature
installed, your computer can be a network client but not a server. This sec-
tion shows you how to enable this feature for Windows XP. For Windows
Vista, see the next section, “Enabling File and Printer Sharing (Windows
Vista).”

If you're lucky, the File and Printer Sharing feature is already set up on your
computer. To find out, double-click the My Computer icon on your desktop.
Select the icon for your C: drive and then click File on the menu bar to reveal
the File menu. If the menu includes a Sharing command, File and Printer
Sharing is already set up, so you can skip the rest of this section. If you can’t
find a Sharing command on the File menu, you have to install File and Printer
Sharing before you can share a file or printer with other network users.

To enable File and Printer Sharing on a Windows XP system, follow these steps:

1. From the Start menu, choose Settings=>Control Panel.
The Control Panel comes to life.

2. Double-click the Network Connections icon.
The Network Connections window appears.

3. Right-click Local Area Connection and choose Properties.

The Local Area Connection properties dialog box appears, as shown in
Figure 3-1.

4. Make sure the File and Print Sharing for Microsoft Networks option is
checked.

5. Click OK.
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Properties
dialog box
|
QING/ . , s . ) .
Oy While you're working in the Network dialog box, don’t mess around with any

of the other network settings. You can safely change the File and Print Sharing
options, but leave the rest of the settings in the Network dialog box alone.

Enabling File and Printer Sharing
(Windows Vista)

To enable file and printer sharing in Windows Vista, follow these steps:

1. Choose Start>Network.
This step opens the Network folder.
2. Click the Network and Sharing Center button on the toolbar.
This step opens the Network and Sharing Center, as shown in Figure 3-2.

3. Click the down arrow to the right of File Sharing in the Sharing and
Discovery section.

This step reveals the controls that enable you to activate file sharing, as
shown in Figure 3-3.
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. Select the Turn on File Sharing option and then click Apply.

This file sharing feature is activated.

. Select the Printer Sharing option.

This step reveals the controls that enable you to activate printer sharing.

. Select the Turn on Printer Sharing option and then click Apply.

This file sharing feature is activated.

. Close the Network and Sharing Center folder.

You're done; you can now share your files and printers.

Enabling File and Printer Sharing
(Windows 7 and 8)

Here are the steps to enable file and printer sharing in Windows 7:

1. Click the Start button, type Control Panel, and press Enter.

This step opens the Control Panel.

. Double-click the Network and Sharing Center icon and then click

Change Advanced Sharing Settings.

This step opens the Advanced Sharing Settings page, which lists net-
work settings for each network you’re connected to.

e For a home computer running Windows 7: Two networks are listed:
Home or Work, and Public.

e In Windows 8: The Home or Work network is called Private.

e For a computer connected to a domain network: A third network
named Domain is listed.

. Click the down arrow next to the network you want to enable file and

printer sharing for.

e For a home computer: Click the down arrow next to Home or Work
(Windows 7) or Private (Windows 8).

e For a computer connected to a domain network: Click the down
arrow next to Domain.

Figure 3-4 shows the settings for a Domain network. The settings for a
Home or Work network are the same.

Do not enable file or printer sharing for the Public network. Enabling file
or printer sharing on a public network exposes your computer’s data to
other users on the same public network.

b5
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|
Figure 3-4:
Enabling file
and printer
sharing in
Windows 8.
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4. Select the Turn on File and Printer Sharing option.
5. Click the Save Changes button.

This action saves your changes and closes the Advanced Sharing
Settings page.

Sharing a Folder

\NG/
§““

To enable other network users to access files that reside on your hard drive,
you must designate a folder on the drive as a shared folder. Note that you can
also share an entire drive, if you so desire. If you share an entire drive, other
network users can access all the files and folders on the drive. If you share

a folder, network users can access only those files that reside in the folder
you share. (If the folder you share contains other folders, network users can
access files in those folders, too.)

Don’t share an entire hard drive unless you want to grant everyone on the net-
work the freedom to sneak a peek at every file on your hard drive. Instead, you
should share just the folder or folders containing the specific documents that
you want others to be able to access. For example, if you store all your Word
documents in the My Documents folder, you can share your My Documents
folder so that other network users can access your Word documents.
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Sharing a folder in Windows XP

To share a folder on a Windows XP computer, follow these steps:

1. Double-click the My Computer icon on your desktop.
The My Computer window comes to center stage.
2. Select the folder that you want to share.

Click the icon for the drive that contains the folder you want to share,
and then find the folder itself and click it.

3. Choose File>Sharing and Security.

The Properties dialog box for the folder that you want to share appears.
Notice that the sharing options are grayed out.

4. Select the Share This Folder on the Network option.

After you select this option, the rest of the sharing options come alive,
as shown in Figure 3-5.

\P . . . .
) If you prefer, you can skip Steps 2-4. Instead, just right-click the folder
you want to share and then choose Sharing and Security from the menu
that appears.
Doug Properties E]@
General | Shanng | Customize
Local sharing and security
“Ta To share this folder with other uzers of this computer
] ,_!,JI only, drag it to the Shared Documents folder.
1 . T ke this fold; d its subfild t that
Figure 3-5: orl you have access, slec the falowing check b
The Sharing
Options Metwork sharing and security
H 4 Toshare this folder with both network d oth
come tO llfe _F_"J usoefs 2}elh\slscuom|:it:‘, selgct ?:e\’\f‘ifsrt c:ﬁ:éiigx Ee\g[’v
When ou and type a share name:
y Share this folder on the network.
select the . 5
. hare name:  |Doug
Sha re ThIS [] &llow network, users to change my files
Folder on
the Network
check box
(In W|nd0WS Learn more about Shar i
XP) ak, ] [ Cancel ] [ Apply
|

5. (Optional) Change the share name if you don’t like the name that
Windows proposes.

The share name is the name that other network users use to access the
shared folder. You can give it any name you want, but the name can be
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no more than 12 characters long. Uppercase and lowercase letters are
treated the same in a share name, so the name My Documents is the
same as MY DOCUMENTS.

Windows proposes a share name for you, based on the actual folder
name. If the folder name has 12 or fewer characters, the proposed share
name is the same as the folder name. If the folder name is longer than
12 characters, however, Windows abbreviates it. For example, the name
Multimedia Files becomes MULTIMEDIA F.

If the name that Windows chooses doesn’t make sense or seems cryp-
tic, you can change the share name to something better. For example, |
would probably use MEDIA FILES rather than MULTIMEDIA F.

. (Optional) If you want to allow other network users to change the

files in this folder, select the Allow Network Users to Change My Files
check box.

If you leave this option deselected, other network users can open your
files, but they can’t save any changes they make.

. Click OK.

The Properties dialog box vanishes, and a hand is added to the icon for
the folder to show that the folder is shared.

If you change your mind and decide that you want to stop sharing a folder,
double-click the My Computer icon, select the folder or drive that you want to
stop sharing, and choose File>Sharing to summon the Properties dialog box.
Deselect the Share This Folder on the Network check box and then click OK.

Sharing a folder in Windows Vista, 7, or 8

To share a folder in Windows Vista, Windows 7, or Windows 8, follow these
steps:

1. Open File Explorer.

e Windows Vista or 7: Choose Start=>Computer.

e Windows 8: Open the desktop and click the File Explorer icon on
the taskbar; then click Computer in the Location list on the left
side of the screen.

2. Navigate to the folder you want to share.

3. Right-click the folder you want to share and choose Properties.

The Properties dialog box appears.

4. Click the Sharing tab and then click the Share button.

The File Sharing dialog box appears, as shown in Figure 3-6.
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The File
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5. Click the arrow in the drop-down list, choose Everyone, and then
click Add.

This action designates that anyone on your network can access the
shared folder.

If you prefer, you can limit access to just certain users. To do so, select
each person you want to grant access to and then click Add.

6. Select the level of access you want to grant each user.

You can use the drop-down list in the Permission Level column to
choose from three levels of access:

® Reader: A reader can open files but can’t modify or create new files
or folders.

e Contributor: A contributor can add files to the share but can change
or delete only her own files.

e Owner: An owner has full access to the shared folder. He or she
can create, change, or delete any file in the folder.

7. Click Share.

A confirmation dialog box appears to confirm that the folder has been
shared.
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Using the Public Folder in Windows
Vista or Windows 7 or 8

A\

Windows Vista, Windows 7, and Windows 8 include an alternative method of
sharing files on the network: the Public folder. The Public folder is simply a
folder that’s designated for public access. Files you save in this folder can be
accessed by other users on the network and by any user who logs on to your
computer.

Before you can use the Public folder, you must enable it. In Windows 7 or 8,
just follow the steps listed in the section “Enabling File and Printer Sharing
(Windows 7 and 8)” earlier in this chapter, but choose the Turn on Sharing
option in the Public Sharing Settings section. For Windows Vista, follow the
steps in the earlier section “Enabling File and Printer Sharing (Windows
Vista),” but choose the Public Sharing option instead of the File Sharing and
Printer Sharing options.

After you enable Public folder sharing, you can access the Public folder on
your own computer in Windows Vista by choosing Start=>Computer and
then clicking the Public icon in the pane on the left side of the window. To
open the Public folder in Windows 7, choose Start=>Computer, expand the
Libraries item in the left pane, and then expand the Documents, Music,
Pictures, or Videos items. In Windows 8, open the desktop, click the File
Explorer icon on the taskbar, expand the Libraries item in the left pane, and
then expand the Documents, Music, Pictures or Videos items.

Figure 3-7 shows an example of a Public folder in Windows 8.

As you can see, the Public folder includes several predefined subfolders
designed for sharing documents, downloaded files, music, pictures, and
videos. You can use these subfolders if you want, or you can create your own
subfolders to help organize the data in your Public folder.

To access the Public folder of another computer, use the techniques that I
describe in Chapter 2 to either browse to the Public folder or map it to a net-
work drive.
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Sharing a Printer

Sharing a printer is much more traumatic than sharing a hard drive. When
you share a hard drive, other network users access your files from time to
time. When they do, you hear your drive click a few times, and your com-
puter may hesitate for a half-second or so. The interruptions caused by other
users accessing your drive are sometimes noticeable but rarely annoying.

When you share a printer, you get to see Murphy’s Law in action: Your co-
worker down the hall is liable to send a 140-page report to your printer just
moments before you try to print a 1-page memo that has to be on the boss’s
desk in two minutes. The printer may run out of paper — or worse, jam —
during someone else’s print job — and you'’re expected to attend to the
problem.

Although these interruptions can be annoying, sharing your printer makes
a lot of sense in some situations. If you have the only decent printer in your
office or workgroup, everyone will bug you to let them use it anyway. You
may as well share the printer on the network. At least this way, they won’t
line up at your door to ask you to print their documents for them.
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Sharing a printer in Windows XP

The following procedure shows you how to share a printer in Windows XP:

1. From the Start menu, choose Printers and Faxes.

The Printers and Faxes folder appears, as shown in Figure 3-8. In this
example, the Printers folder lists a single printer, named HP PSC 750.

B Printers and Faxes El@le
File Edit VWiew Favorites Tools Help :,'
O Back - </ .? /._E Search |( - Folders v

o RS

Printer Tasks &) “\\-,é

[2] Add a printer

& Set up faxing

See Also

2] Troubleshaot printing

@) Get help with printing

|
Figure 3_8: Dther Places
The Printers
and Faxes

folder.

B control Panel
% Scanners and Cameras
3 My Documents

iﬂ My Pictures

2. Select the printer that you want to share.
Click the icon for the printer to select the printer.
3. Choose Filew>Sharing.

You're right: This command doesn’t make sense. You're sharing a
printer, not a file, but the Sharing command is on the File menu. Go
figure.

When you choose Filer>Sharing, the Properties dialog box for the printer
appears.

4. Select the Share This Printer option.

5. (Optional) Change the share name if you don’t like the name sug-
gested by Windows.

Other computers use the share name to identify the shared printer, so
choose a meaningful or descriptive name.

6. Click OK.

You return to the Printers folder, where a hand is added to the printer
icon to show that the printer is now a shared network printer.
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|
Figure 3-9:
Sharing a
printer in
Windows 8.
|

To take your shared printer off the network so that other network users can’t
access it, follow Steps 1-3 in the preceding set of steps to open the Printer
Properties dialog box. Select the Do Not Share This Printer option and then
click OK. The hand disappears from the printer icon to indicate that the
printer is no longer shared.

Sharing a printer in Windows UVlista,
Windows 7, or Windows 8

To share a printer in Windows Vista, Windows 7, or Windows 8, follow these
steps:

1. Open the Control Panel.

e Windows 7 or earlier: Choose Start=>Control Panel.

e Windows &8: Press the Windows key, type Control, and then click
the Control Panel icon.

2. Click Devices and Printers.

3. Right-click the printer that you want to share and choose Printer
Properties.

The Properties dialog box for the printer appears.
4. Click the Sharing tab.

The Sharing tab appears, as shown in Figure 3-9. Notice that the options
for sharing the printer are disabled.

!;__I x
General | Sharing | Ports | Advanced | Color Management | Security | Accessories | Advanced Options
You can share this printer with other users on your network. The

printer will not be available when the computer is sleeping or turned
off.

i

e i s

Render print jobs on client computers

List in the directory

Drivers
If this printer is shared with users running different versions of
Windows, you may want to install additional drivers, 5o that the
users do not have to find the print driver when they connect to the
shared printer.

Additional Drivers...

Cnce | o |
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5. Select the Share This Printer option.

6. (Optional) Change the share name if you don’t like the name sug-
gested by Windows.

Because other computers will use the share name to identify the shared
printer, pick a descriptive name.

7. Click OK.

You return to the Printers folder. The icon for the printer is modified to
indicate that it has been shared.

To take your shared printer off the network so that other network users can’t
access it, follow Steps 1-4 in the preceding set of steps. Deselect the Share
This Printer check box and then click OK.

Using Microsoft Office on a Network

Microsoft Office is far and away the most popular suite of application programs
used on personal computers, and it includes the most common types of
application programs used in an office: a word processing program (Word), a
spreadsheet program (Excel), a presentation program (PowerPoint), and an
excellent e-mail program (Outlook). Depending on the version of Office you
purchase, you may also get a database program (Access), a desktop publishing
program (Publisher), a set of Ginsu knives (KnifePoint), and a slicer and dicer
(ActiveSalsa).

This section describes the networking features of Microsoft Office System
2010, the latest and greatest version of Office. Most of these features also
work with previous versions of Office.

To get the most from using Office on a network, you should purchase the
Microsoft Office Resource Kit. The Office Resource Kit, also known as ORK,
contains information about installing and using Office on a network and comes
with a CD that has valuable tools. If you don’t want to purchase the ORK, you
can view it online and download the ORK tools from the Microsoft TechNet
website (http://technet.microsoft.com/en-US/). Nanoo-nanoo,
Earthling.

Installing Office on a network —
some options

You need to make some basic decisions when you prepare to install
Microsoft Office on a network. In particular, here are some possible
approaches to installing Microsoft Office on your network clients:
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» You can simply ignore the fact that you have a network and purchase
a separate copy of Office for each user on the network. Then you can
install Office from the CD on each computer. This option works well if

® Your network is small.

e Each computer has ample disk space to hold the necessary Office
files.

¢ Each computer has its own CD-ROM drive. (If the computer doesn’t
have a CD-ROM drive, you can share a CD-ROM drive on another
computer and install the software from the shared drive.)

v On a larger network, you can use the Office Setup program in
Administrative Setup mode. This option lets you create a special type
of setup on a network server disk from which you can install Office on
network computers. Administrative Setup enables you to control the
custom features selected for each network computer and reduce the
amount of user interaction required to install Office on each computer.

If you choose to use Administrative Setup, you can use the Network
Installation Wizard, which comes with the Office Resource Kit. The
Network Installation Wizard lets you customize settings for installing
Office on client computers. For example, you can choose which Office
components to install, provide default answers to yes/no questions
that Setup asks the user while installing Office, and select the amount
of interaction you want the Setup program to have with the user while
installing Office.

No matter which option you choose for installing Office on your network, you
must purchase either a copy of Office or a license to install Office for every
computer that uses Office. Purchasing a single copy of Office and installing it
on more than one computer is illegal.

Accessing network files

Opening a file that resides on a network drive is almost as easy as opening a
file on a local drive. All Office programs use File=>Open to summon the Open
dialog box, as shown in its Excel incarnation in Figure 3-10. (The Open dialog
box is nearly identical in other Office programs.)

To access a file that resides on a network volume that’s mapped to a drive
letter, all you have to do is use the drop-down list at the top of the dialog box
to select the network drive.

You can map a network drive directly from the Open dialog box by navigating
to the folder you want to map, right-clicking the folder, and choosing Map
Network Drive.

55
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Figure 3-10:
The Open
dialog box in
Excel 2010.
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If you try to open a file that another network user has opened already, Office
tells you that the file is already in use and offers to let you open a read-only
version of the file. You can read and edit the read-only version, but Office
doesn’t let you overwrite the existing version of the file. Instead, you have to
use the Save As command to save your changes to a new file.

Using workgroup templates

Although an occasional sacrifice to the Office gods may make your computing
life a bit easier, a template isn’t a place of worship. Rather, a template is a
special type of document file that holds formatting information, boilerplate
text, and other customized settings that you can use as the basis for new
documents.

Three Office programs — Word, Excel, and PowerPoint — enable you to
specify a template whenever you create a new document. When you create a
new document in Word, Excel, or PowerPoint by choosing File=> New, you see
a dialog box that lets you choose a template for the new document.

Office comes with a set of templates for the most common types of documents.
These templates are grouped under the various tabs that appear across the
top of the New dialog box.

In addition to the templates that come with Office, you can create your own
templates in Word, Excel, and PowerPoint. Creating your own templates is
especially useful if you want to establish a consistent look for documents pre-
pared by your network users. For example, you can create a Letter template
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that includes your company’s letterhead or a Proposal template that includes
a company logo.

Office enables you to store templates in two locations. Where you put them
depends on what you want to do with them:

1 The User Templates folder on each user’s local disk drive: If a particular
user needs a specialized template, put it here.

1 The Workgroup Templates folder on a shared network drive: If you
have templates that you want to make available to all network users on
the network server, put them here. This arrangement still allows each
user to create templates that aren’t available to other network users.

When you use both a User Templates folder and a Workgroup Templates
folder, Office combines the templates from both folders and lists them in
alphabetical order in the New dialog box. For example, the User Templates
folder may contain templates named Blank Document and Web Page, and

the Workgroup Templates folder may contain a template named Company
Letterhead. In this case, three templates appear in the New dialog box, in this
order: Blank Document, Company Letterhead, and Web Page.

To set the location of the User Templates and Workgroup Templates folders,
follow these steps in Microsoft Word:
1. Click the Office button and then click Word Options.
The Word Options dialog box opens.
2. Click the Advanced tab.
The Advanced options appear.

3. Scroll down to the General section and then click the File Locations
button.

The File Locations dialog box appears, as shown in Figure 3-11.
4. Double-click the Workgroup Templates item.

This step opens a dialog box that lets you browse to the location of your
template files.

5. Browse to the template files and then click OK.
You return to the File Locations dialog box.

6. Click OK to dismiss the File Locations dialog box.
You return to the Word Options dialog box.

7. Click OK again.
The Word Options dialog box is dismissed.
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Figure 3-11:
Setting the
file loca-
tionsin
Word 2010.

\\3

File Locations

File types: Location:

ers\Doug. DOMAIN'Doc
Clipart pictures

User templates C:\... \RoamingMicrosoft{Templates
Workgroup templates

AutoRecover files C:\,...\RoamingMicrosoftiword
Tools C:\,...\Microsoft Office\Office 14
Startup V.. WMicrosoft\Word\STARTUP

OK Close

Although the User Templates and Workgroup Templates settings affect Word,
Excel, and PowerPoint, you can change these settings only from Word. The
Options dialog boxes in Excel and PowerPoint don’t show the User Templates
or Workgroup Templates options.

When you install Office, the standard templates that come with Office

are copied into a folder on the computer’s local disk drive, and the User
Templates option is set to this folder. The Workgroup Templates option is
left blank. You can set the Workgroup Templates folder to a shared network
folder by clicking Network Templates, clicking the Modify button, and speci-
fying a shared network folder that contains your workgroup templates.

Networking an Access database

If you want to share a Microsoft Access database among several network users,
be aware of a few special considerations. Here are the most important ones:

»* When you share a database, more than one user may try to access the
same record at the same time. This situation can lead to problems if two
or more users try to update the record. To handle this potential traffic
snarl, Access locks the record so that only one user at a time can update
it. Access uses one of three methods to lock records:

e Fdited Record: This method locks a record whenever a user begins
to edit a record. For example, if a user retrieves a record in a form
that allows the record to be updated, Access locks the record
while the user edits it so that other users can’t edit the record
until the first record is finished.
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e No Locks: This method doesn’t really mean that the record isn’t
locked. Instead, No Locks means that the record isn’t locked until
a user writes a change to the database. This method can be con-
fusing to users because it enables one user to overwrite changes
made by another user.

e All Records: All Records locks an entire table whenever a user edits
any record in the table.

v Access lets you split a database so that the forms, queries, and reports
are stored on each user’s local disk drive, but the data itself is stored on
a network drive. This feature can make the database run more efficiently
on a network, but it’s a little more difficult to set up. (To split a database,
choose Tools=>Database Utilities=>Database Splitter.)

v Access includes built-in security features that you should use if you share
an Access database from a Windows client computer. If you store the
database on a domain server, you can use the server’s security features
to protect the database.

v Access automatically refreshes forms and datasheets every 60 seconds.
That way, if one user opens a form or datasheet and another user changes
the data a few seconds later, the first user sees the changes within one
minute. If 60 seconds is too long (or too short) an interval, you can change
the refresh rate by using the Advanced tab in the Options dialog box.

Working with Offline Files

Desktop computers are by nature stationary beasts. As a result, they're
almost always connected to their networks. Notebook computers, however,
are more transitory. If you have a notebook computer, you're likely to tote

it around from place to place. If you have a network at work, you probably
connect to the network when you're at work. But then you take the notebook
computer home for the weekend, and you aren’t connected to your network.

Of course, your boss wants you to spend your weekends working, so you
need a way to access your important network files while you're away from
the office and disconnected from the network. That’s where the offline files
feature comes in. It lets you access your network files even while you're
disconnected from the network.

It sounds like magic, but it isn’t really. Imagine how you’d work away from
the network without this feature. You simply copy the files you need to work
on to your notebook computer’s local hard disk. Then, when you take the
computer home, you work on the local copies. When you get back to the
office, you connect to the network and copy the modified files back to the
network server.
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That’s essentially how the offline files feature works, except that Windows
does all the copying automatically. Windows also uses smoke and mirrors to
make it look like the copies are actually on the network even though you’re
not connected to the network. For example, if you map a drive (drive M:, for
example) and make it available offline, you can still access the offline copies
of the file on the M: drive. That’s because Windows knows that when you
aren’t connected to the network, it should redirect drive M: to its local copy
of the drive M: files.

The main complication of working with offline files, of course, is what happens
when two or more users want to access the same offline files. Windows can
attempt to straighten that mess out for you, but it doesn’t do a great job of

it. Your best bet is to not use the offline files feature with network resources
that other users may want available offline, too. In other words, it’s okay to
make your home drive available offline because that drive is accessible only
to you. I don’t recommend making shared network resources available offline,
though, unless they’re read-only resources that don’t contain files you intend
to modify.

Using the offline files feature is easy:

v Windows Vista, Windows 7, or Windows 8: Open the Computer folder,
right-click the mapped network drive you want to make available offline,
and choose Always Available Offline.

1 Windows XP: Open My Computer, right-click the mapped drive, and
choose Make Available Offline.

If you don’t want to designate an entire mapped drive for offline access, you
can designate individual folders within a mapped drive by using the same
technique: Right-click the folder and then choose Always Available Offline
(Make Available Offline in Windows XP).

When you first designate a drive or folder as available offline, Windows
copies all the files on the drive or folder to local storage. Depending on how
many files are involved, this process can take a while, so plan accordingly.

After you designate a drive as available offline, Windows takes care of the
rest. Each time you log on to or out of the network, Windows synchronizes
your offline files. Windows compares the time stamp on each file on both the
server and the local copy and then copies any files that have changed.

Here are a few other thoughts to consider about offline files:

v If you want, you can force Windows to synchronize your offline files by
right-clicking the drive or folder and choosing Sync.

v Make sure that no files in the folder are currently open at the time you
set the Make Available Offline option. If any files are open, you'll receive
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an error message. You have to close the open files before you can desig-
nate the folder for offline access.

v The Properties dialog box for mapped drives includes an Offline Files
tab, as shown in Figure 3-12.

v Employers love the offline files feature because it encourages their
employees to work at home during evenings and weekends. In fact,
every time you use the offline files feature to work at home, your boss
sends Bill Gates a nickel. That’s how he got so rich.

General | Security | Previous Versions | Customize | Offiine Files

. . ProjectData
l@ Location: “\BCFWEBT
I

“S=. Thisfolderis anline.

“ou can keep a copy of this network folder on your computer
=0 you can access its files when the serveris not available

Sync now...

How do offline files work?
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web Find out a great way to test the network you set up at www . dummies . com/
i1 cxtras/networking
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In this part...

Creating a network plan
Understanding and using TCP/IP

Working with cables, network adapters, switches, and other
important networking components

Configuring Windows computers for networking
Getting connected to the Internet

Using wireless devices in your network
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In This Chapter

Making a network plan

Taking stock of your computer stock

Making sure that you know why you need a network

Making the three basic network decisions that you can’t avoid
Using a starter kit

Looking at a sample network

Okay, so you're convinced that you need to network your computers.
What now? Do you stop by Computers-R-Us on the way to work, install
the network before drinking your morning coffee, and expect the network to
be fully operational by noon?

I don’t think so.

Networking your computers is just like any other worthwhile endeavor: Doing
it right requires a bit of planning. This chapter helps you to think through
your network before you start spending money. It shows you how to come

up with a networking plan that’s every bit as good as the plan that a network
consultant would charge thousands of dollars for. See? This book is already
saving you money!

Making a Network Plan

Before you begin any networking project, whether a new network installation
or an upgrade of an existing network, start with a detailed plan. If you make
technical decisions too quickly before studying all the issues that affect the
project, you'll regret it. You’ll discover too late that a key application won’t
run over the network, the network has unacceptably slow performance, or
key components of the network don’t work together.
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Here are some general thoughts to keep in mind while you create your net-
work plan:

v Don’t rush the plan. The most costly networking mistakes are the ones
that you make before you install the network. Think things through and
consider alternatives.

1 Write down the network plan. The plan doesn’t have to be a fancy, 500-
page document. If you want to make it look good, pick up a small three-
ring binder. This binder will be big enough to hold your network plan
with room to spare.

1 Ask someone else to read your network plan before you buy anything.
Preferably, ask someone who knows more about computers than you do.

1 Keep the plan up to date. If you add to the network, dig up the plan,
dust it off, and update it.

<P “The best laid schemes of mice and men gang aft agley, and leave us naught
but grief and pain for promised joy.” Robert Burns lived a few hundred years
before computer networks, but his famous words ring true. A network plan
isn’t chiseled in stone. If you discover that something doesn’t work how you
thought it would, that’s okay. Just change your plan.

Being Purposeful

One of the first steps in planning your network is making sure that you under-
stand why you want the network in the first place. Here are some of the more
common reasons for needing a network, all of them quite valid:

v My co-worker and I exchange files using CDs or flash drives just about
every day. With a network, it would be easier to trade files.

v [ don’t want to buy everyone a color laser printer when [ know the one
we have now just sits there taking up space most of the day. So wouldn’t
investing in a network be better than buying a color laser printer for
every computer?

v [ want everyone to be able to access the Internet. (Many networks, espe-
cially smaller ones, exist solely for sharing an Internet connection.)

v Business is so good that one person typing in orders eight hours each
day can’t keep up. With a network, I can have two people entering
orders, and [ won’t have to pay overtime to either person.

v My brother-in-law just put in a network at his office, and [ don’t want him
to think that 'm behind the times.

v | already have a network, but it’s so old it may as well be made of kite
string and tin cans. An improved network will speed up access to shared
files, provide better security, and be easier to manage.
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Make sure that you identify all the reasons why you think you need a network
and then write them down. Don’t worry about winning the Pulitzer Prize for
your stunning prose. Just make sure that you write down what you expect a
network to do for you.

If you were making a 500-page networking proposal, you'd place the descrip-
tion of why a network is needed in a tabbed section labeled “Justification.” In
your network binder, file the description under “Purpose.”

As you consider the reasons why you need a network, you may conclude that
you don’t need a network after all. That’s okay. You can always use the binder
for your stamp collection.

Taking Stock

One of the most challenging parts of planning a network is figuring out how
to work with the computers that you already have. In other words, how do
you get from here to there? Before you can plan how to get “there,” you have
to know where “here” is. In other words, you have to take a thorough inventory
of your current computers.

What you need to know

You need to know the following information about each of your computers.
Don’t sweat it right now if some of these terms don’t make sense. They're all
just pieces of the puzzle.

v The processor type and, if possible, its clock speed: It would be nice
if each of your computers had a shiny new Core i7 six-core processor.
In most cases, though, you find a mixture of computers: some new,
some old, some borrowed, some blue. You may even find a few archaic
Pentium computers.

You can’t usually tell what kind of processor that a computer has just
by looking at the computer’s case. Most computers, however, display
the processor type when you turn them on or reboot them. If the infor-
mation on the startup screen scrolls too quickly for you to read it, try
pressing the Pause key to freeze the information. After you finish reading
it, press the Pause key again so that your computer can continue booting.

v The size of the hard drive and the arrangement of its partitions: To
find out the size of your computer’s hard drive in Windows 8, 7, or Vista,
open the Computer window (click Start, then click Computer), right-click
the drive icon, and choose the Properties command from the shortcut
menu that appears. Figure 4-1 shows the Properties dialog box for a
922GB hard drive that has about 867GB of free space.
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